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Chapter 1: Introduction

As part of Microware’s policy of continued product development, 
Enhanced OS-9 version 3.2 represents a maintenance and update 
release to incorporate all of the improvements that have been 
introduced into the component parts. 

NoteNote
These release notes cover the changes made to the Enhanced OS-9 
package in the time since the previous release. If upgrading from an 
earlier version, these release notes should be read in conjunction with 
the relevant older release notes.

NoteNote
Files for OS-9 version 3.2 are updates to previous product releases. 
Although these files are intended to be installed on top or your existing 
version of OS-9, it is recommended that you complete a backup of your 
system before installation.
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Chapter 2: Operating System

This chapter provides an overview of the changes and improvements 
made to OS-9 since the last release. The following sections are 
included:

• Operating System Notes
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2 Operating System

Operating System Notes

The following sections represent changes and updates for OS-9 version 
3.2. The OS-9 kernel edition is 142.

Resolved Problems

• CF9912: The DEC21140 low-level driver does not work correctly 
when the flshcach module is not present in the system and the 
cache module is present in the bootfile. 

The flshcach module should be always present in the system. The 
Wizard does not allow the flshcach module to be excluded from 
coreboot.

The flshcach module is required by the low-level driver to do cache 
flushing on buffers that may be cached and used by the chip for 
DMA. When the cache module is running caching is turned on for 
the system; thus, the low-level driver is expected to do cache 
flushes. In the absence of the flshcach module, you should integrate 
the cache flushing code in each low-level driver. The flshcach 
module allows for the cache flush code for the low-level system to be 
present in a single module rather than duplicating it in all drivers. 
Therefore, this module should be always used when using low-level 
drivers.

• CF12358: Intel pro 100 high level driver needs a way of over-riding 
MAC address.

Edition #14 of the SPPRO100 driver now honors the MAC address 
supplied in the port specific SPF/SPPRO100/DEFS/spf_desc.h 
file. By default, support should be disabled for this feature since the 
MAC hardware address of the card needs to be resolved at the 
hardware level. 
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The MAC address held in the 82559 part and its setup information 
exist on the Intel Ethernet PRO series. To enable the MAC address 
override feature within the configuration Wizard, the following 
statement needs to be added: 

The port specific ini file normally does not 
display the MAC address. To display the MAC 
address for editing with in the Wizard change the 
SPF_MAC define to true. [SUPPORTED_MODULES]

SPF_MAC=TRUE

Additionally, set the port specific.ini file to make the SPF 
descriptor on each build. The following example shows how to 
change the X86-specific .ini file to make the SPF descriptor. Note 
the Ethernet_Controller numbers used.

[ETHERNET_CONTROLLERS]

ETHER_0=3COM PCI series

ETHER_1=3COM ISA EtherLink III

ETHER_2=3COM EtherLink III PC Card

ETHER_3=DEC 21140

ETHER_4=Intel Pro100 Series

ETHER_5=Realtek RTL8139A

ETHER_6=SMC 91C94/96

ETHER_7=LAN79C961/AM79C973 

ETHER_8=NE2000

ETHER_9=NE2000 PC Card

ETHER_10=Spectrum24 Wireless Card

ETHER_11=Netgear FA311

ETHER_12=Cirrus Logic CS8900 (ISA)

ETHER_13=None

DEFAULT=0
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2 Operating System

In this case, the INTEL Ethernet PRO100 series card is ETHER_4. 
To enable SPF descriptors for the SPPRO100 driver to be made 
during Wizard build, add or change the following code:

; 

;

[MAKE_SPF_DESC]

ETHER_4_RPATH=SPF\SPPRO100

CMD=Os9make

PARAMS=-f=spfdesc.mak COPTS=-dCONFIGURER clean all

The following lines should also appear in the 
<PORT>SPF/SPPRO100/DEFS/spf_desc.h file.

#if defined(CONFIGURER)

#include "../../../config.h"

#else

#define EA0 0

#define EA1 0

#define EA2 0

#define EA3 0

#define EA4 0

#define EA5 0

#endif

• CF12553: PCF and pcformat handled fsinfo structure in FAT32 
incorrectly.

After formating a disk with pcformat, a scandisk check under 
Windows 98 showed a corrupt disk. This has been fixed in pcforma; 
thus, once the disk is formatted with pcformat, scandisk on windows 
98 should not report any problem. It was also checked it with 
pcdcheck; it passes the test as well.
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• CF12637: PCF hanged the system if removable device was inized 
with FAT16 media, then removed and FAT32 media was installed 
and accessed.

PCF allocated a FAT16 buffer and re-used the buffer when the 
FAT32 media was installed. Since a FAT32 buffer is larger than 
FAT16, this corrupted memory after the end of the buffer. PCF now 
returns and re-allocates the correct sizes of memory, depending on 
FAT type of media installed.

• CF12755: The iop_id field in the I/O process desc is no longer 
filled in.

Since the introduction of threading (3.0), the iop_id field of an I/O 
process descriptor was not being filled in. This oversight has been 
corrected and ioman is now correctly initializing the value to be the 
initial process ID of the owner of the I/O process descriptor.

Known Issues

• CF11264, 11872: Killing FTP during login will cause the controlling 
shell to hang. FTPDC blocks the system if wrong user/password is 
used with FTP.

This is a bug in the kernel in which file I/O is handled incorrectly for 
pseudo-threaded applications. 

• CF14187: The kernel's copyright message does not reflect RadiSys, 
OS-9 v3.2, or the correct year.

• CF14234: format does not handle <Esc> well at prompt.

If you press <Esc> at a prompt of the format command, format 
will repeated scroll the prompt. Exit by pressing <Esc> to resolve 
this problem.
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Chapter 3: IXP1200 Notes

This chapter provides an overview of the changes and improvements 
made to Enhanced OS-9 for IXP1200. The following sections are 
included:

• Enhanced OS-9 for IXP1200 v3.2
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3 IXP1200 Notes

Enhanced OS-9 for IXP1200 v3.2

The following section represents changes and updates for OS-9 for 
IXP1200 version 3.2.

Enhancements

• A driver has been added for the Intel IXM1200 that supports the 
IXF440 Fast Ethernet and also initializes the ATM daughter card. 
This driver works in conjunction with the Microcode Solutions Library 
"atmeth" microcode, compiled as uenginit_atmeth. This driver 
build directory is 
/MWOS/OS9000/ARMV4/PORTS/IXP1200/SPF/SPIXP_CMB, and 
uses source from /MWOS/SRC/DPIO/SPF/DRVR/SPETH_IXP.

• The IXF440 Ethernet driver SPETH_IXP will now attempt to query 
the connected device in order to determine if the connection 
supports a full duplex connection. The link will be set to half duplex if 
the connected device is incapable of running full duplex; otherwise, 
full duplex is used. This is done in an attempt to prevent problems 
with the IXF440 that arise when connected to half duplex devices. 
This query is done only at driver initialization time.
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Chapter 4:  ARM/StrongARM Notes

This chapter provides an overview of the changes and improvements 
made to Enhanced OS-9 for ARM/StrongARM. The following sections 
are included:

• Enhanced OS-9 for ARM/StrongARM v3.2
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4 ARM/StrongARM Notes

Enhanced OS-9 for ARM/StrongARM v3.2

The following sections represent changes and updates for OS-9 for 
ARM/StrongARM version 3.2.

Resolved Problems

• CF11199: Configuration Wizard problem.

Ipstart string is not needed in the default parameter list. The default 
value of IPSTART has been changed to FALSE in 
armv4/ports/pid7t/boots/install/ini/pid7t.ini.

• CF12008: sc1101 keyboard and mouse do not work on Assabet.

The PS/2 keyboard and mouse driver has not been ported to the 
Assabet development board.

• CF12016: Low level Ethernet driver ll8900 problem.

The low level ethernet driver ll8900 was trying to send packets when 
the link was down. The problem was fixed; a time out has been 
added to send_packet.

• CF12361: ATA bootdisk (PCMCIA).

The RBF descriptors were not being built correctly. You can now 
make a boot disk in RBF format instead of PCF format for Assebet 
and GraphicsClient.

• CF12669: Problems using libgen to list extended information 
(netapp.l). 

hw_svlib_tests.cpp has been removed from the makefile 
because it is not necessary and can cause problems with libgen. 
The change is reflected in netapp.l edition #2.
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Enhancements

• CF11051: The ARMv4 compiler needs 64-bit long long support.

The ARM targets for Ultra C/C++ now supports the data type "long 
long" as a 64-bit integer. Previously, the long long data type was 
accepted, but it was considered 32 bits. In addition, the printf and 
scanf family of functions have been enhanced to include the “L” 
modifier, which indicates that an object of type long long is being 
referred.

Compiler Issues

In order to reduce the memory usage, it was necessary to make C++ 
exception handling incompatible for SuperH. All code that uses 
exception handling need to be recompiled in order to be compatible with 
the C++ libraries. This change will result in significant savings in stack 
and global memory.
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Chapter 5: MIPS Notes

No additions have been made to MIPS since the last release. 

For More Information
More In
fo More 
Informatio
n More Inf
ormation M
ore Inform
ation More

-6-

For the latest MIPS release notes, refer to the Enhanced OS-9 
Release Notes v3.1 document, included with this CD.



22 Enhanced OS-9 Release Notes

5 MIPS Notes



6PowerPC Notes

Enhanced OS-9 Release Notes 23

Chapter 6: PowerPC Notes

This chapter provides an overview of the changes and improvements 
made to Enhanced OS-9 for PowerPC. The following sections are 
included:

• Enhanced OS-9 for PowerPC v3.2

NoteNote
For 405 and 555 Users:

At the time of this release, the 405 and 555 target processors had not 
been fully tested. Please check with your support office for an update.
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6 PowerPC Notes

Enhanced OS-9 for PowerPC v3.2

The following sections represent changes and updates for OS-9 for 
PowerPC version 3.2.

Resolved Problems

• CF9533: Watching IRQs by ROMBug.

Dbgserv/Rombug/dbgentry changed to allow ov to work on 
virtual vectors when the high level system is up.

• CF10104: SCC registers in cpm.h.

The SCC register defines have been corrected.

• CF10205: Three bugs in pcisub.

The following subroutine and trap module numbers have been 
moved to module.h to avoid conflicts; all subroutine and trap 
module numbers should be defined in module.h in the future:

#define SLIB_CSL     0

#define SLIB_MATH    1

#define SLIB_PCI     2

#define SLIB_MAUI    8

#define SLIB_NETDB   9

• CF10380: Patch in scspu driver for PPC403.

The scspu driver 
(mwos/os9000/src/io/scf/drvr/scspu/term.c) was 
modified so that when a non-inized device is written to and 
terminated, it will wait for the output buffer to empty before shutting it 
down.
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• CF10614: pccard for 860FADS.

The ability to boot an 860FADS board from the PCMCIA device was 
added. PCMCIA booter sources were added to the 
/mwos/OS9000/821/PORTS/8XXFADS/ROM/PCCARD directory. 
Also added were two libraries: 
/mwos/OS9000/PPC/LIB/m821hba.l and 
/mwos/OS9000/PPC/LIB/pccislib.l.

• CF10658: MAUI support for MVME2700.

There was a conflict between the graphics card and the SCSI and 
ethernet controllers on the PCI bus. The solution was to recompile 
the SCSI and ethernet drivers with PCI_IO_MAPPED enabled.

• CF10838: The Wizard wants to put csfd in the init string
(860TFADS).

The csfd will still be added to the init string if it is selected in the 
build window whether it was there or not when you left the disk 
window.

• CF11023: SandPoint Rev 3 hardware changes cause OS-9 and 
Ethernet drivers to fail.

The debug version (-g) of the makefile in the SPF driver 
(/mwos/OS9000/8240/PORTS/SANDPOINT/SPF/SPE509/ 
spfdrvr.mak) was modified to statically link against the library 
rather than the subroutine module. When the driver is ready for 
production, you can link it against the subroutine module. Also, the 
module, commcnfg, was added to the coreboot.ml file in the 
Sandpoint port.
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6 PowerPC Notes

• CF11271: 16Mb RAM disk (Wizard for Sandpoint III). 

Even though there is 32M of RAM on the board, the high level 
memory split memory into two segments of 16M each. Therefore, 
there was not enough RAM to allocate a 16M RAM disk. This fix 
merged these segments together into on 32M contiguous piece of 
memory by removing one of the memory segments and expanding 
the initial segment to 32M. This change occurred in the 
default.des file in the  
<MWOS>OS9000/8240/PORTS/SANDPOINT/INIT directory. This 
allows the user to select a 16M RAM disk and build bootfile that has 
enough RAM to allocate the disk.

• CF11327: Empty term_t1 is generated in MP5 directory.

/MWOS/OS9000/SRC/IO/SCF/DRVR/SC555/sc555.h has been 
changed to conditionalize the sc555.edm inclusion, because 
without the condition, the makefile will crash. 

• CF11479: The 600 series cache module does not support cache 
line invalidates.

Edition #29 of the 603, 604, 750, 8240, 8260 cache modules now 
supports ranged cache invalidates, as well as cache store with no 
invalidate options.

• CF11573, 24963: Cache works fine on its own, but not if SSM is 
included.

The bat3 segment search code for 604/750 has been fixed. It no 
longer incorrectly loads the wrong entry in bat3.

• CF11729: Problem with Rombug on PPC 401 - single step and 
breakpoints.

The cachflush module did not correctly size all variants of the 401 
processor. This has been corrected.

• CF11916: ROM vectors for PPC V1.4 ROMbug are broken.

Dbgserv/Rombug/dbgentry has been changed to use 
exception/vectors instead of direct probes.
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• CF12121: TFTP bootfile transfer sometimes hangs.

Dbgserv/Rombug/dbgentry changed to use exception/vectors 
instead of direct probes. The direct probes could corrupt memory 
when the exception module was not present.

• CF12234: The PPC 600 series of cache modules is masking IRQ's 
during flushing operations.

Edition #28 of the 603, 604, 750, 8240, and 8260 cache modules no 
longer masks IRQs during cache flushing, cache invalidating, or 
cache storing functions. There is still a small amount of needed IRQ 
masking when changing or altering system global variables.

• CF12296: Hawk does not show line number on bus trap. 

Previously, on a bus trap the PowerPC kernel would return memory 
trying to be referenced instead of returning the line number of the 
command causing the bus trap. 

The parameter returned on data and alignment exceptions has been 
modified; it is now the address of the instruction causing the 
exception instead of the memory trying to be accessed. This 
information allows Hawk to point to the line number of the instruction 
causing the bus trap.
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6 PowerPC Notes

Enhancements

• CF9889: long long (64bit integer) support needed.

The PowerPC targets for Ultra C/C++ now supports the data type 
"long long" as a 64-bit integer. Previously, the long long data type 
was accepted, but it was considered 32 bits. In addition, the printf 
and scanf family of functions have been enhanced to include the “L” 
modifier, which indicates that an object of type long long is being 
referred.

• CF10470, 11787: Ultra C/C++ needs a 405 target. PowerPC 555 
target for all Compiler elements.

The compiler executive, xcc, now has PowerPC 405 and 555 
targets. cpu.l was also updated to include functions to get and set 
405 and 555 specific SPRs and DCRs. Refer to 
\MWOS\OS9000\PPC\getset.h for the new function names. 
editmod and mkdatmod were also changed to allow for 405 and 555 
targets.

• Code and makefiles for the GX_IG5050 graphics driver and 
descriptor have been removed.

Known Issues

• CF14203: For the MCP750 board: A module load failure due to 
wrong IP address yields a gray screen. You must exit Hawk to 
resolve this error.

• CF14237: Running the aloha and winink MAUI demos, then 
exiting aloha, causes color discrepancies in the winink demo.

• CF14202: bootptest never does not terminate properly. You must 
exit the process to resolve this error.
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• CF14199: High-level networking does not work with v3.0 dbgentry 
and dbgserv.

If the dbgentry and dbgserv modules from the 3.0 release are 
used with the 3.2 release, high-level networking will not function. 
Using 3.2 versions will allow high-level networking to work.

• CF14244: Adding PCI graphics cards to Sandpoint 8240 causes 
booting problems.

The sandpoint 8240 will not work simultaneously with an Intel 
Ethernet card and a graphics device plugged into the PCI bus. 

• CF14188: USB peripheral: Hawkview fails to load a module using 
drag-and-drop.

The functionality that allows the Hawkview tool to load a module by 
dragging it to the module directory fails. Modules can still be 
dragged to the remote disk and loaded via the console.

• CF14253: SBC8260: The Wizard .ini defaults do not allow for 
pings greater than 53000 bytes.
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Chapter 7: SuperH Notes

This chapter provides an overview of the changes and improvements 
made to Enhanced OS-9 for SuperH. It covers both the SH-3 and SH-4 
processor families. The following sections are included:

• Enhanced OS-9 for SuperH v3.2
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7 SuperH Notes

Enhanced OS-9 for SuperH v3.2

The following sections represent changes and updates for OS-9 for 
SuperH version 3.2.

Resolved Problems

• CF10197: Power management on SH3 does not work.

This is a problem with a mismatch between the.des file that made 
the serial descriptor and the.h file for the driver. The added fields 
needed for power management was being included in the.des file, 
and as a result, the serial descriptor. The driver was not being 
compiled with the PWRAWARE flag, so the logical unit data area 
allocated for the driver was not being allocated the extra fields 
needed for power management. 

When the serial descriptor was inized, the init_data that copied 
logical unit data from the descriptor to the driver's logical unit data 
area would corrupt memory. This mismatch has been corrected, so 
compiling the driver and descriptor with the PWRAWARE on or off 
will result in the same structure.

• CF10454: The Wizard cannot build pflashrom from ROM with SH-4 
v1.1, but can in SH-3 v1.1.

A makefile in the SH7750SE directory was corrected to enable the 
making of a boot that could burn the flash with a ROM image.

• CF11578: idbgen, TLB miss in csl.

idbgen has been recompiled to eliminate this problem.

• CF11756: input_error_irq(), SH-3 and SH-4.

The way in which input error ISR detects and clears the framing, 
over-run, and parity errors in SH-3 and SH-4 SCI drivers has been 
fixed.



7SuperH Notes

Enhanced OS-9 Release Notes 33

Enhancements

• CF8763: Enhance pc-relative move code in optsh.

The SH-3 and SH-4 assembly code optimizers were enhanced to try 
to put PC-relative data where it more naturally fits--after 
unconditional branches or function returns. This results in fewer 
run-time branches over in-line data.

• CF12010: Update systype.h input clock definition (Xtal on 
MS7750SE01) 

INPUT_CLOCK in the SH-4 port SH7750SE has been changed from 
30000000 to 33333333 to more precisely reflect the value of 
crystal-clock oscillator on the board.

• CF12147: /kx0 freeze, sc8042k.

Code was added for SH-4 to the sc8042k driver to flush the 
keyboard buffer before deinitializing the device. Previously, the 
keyboard device was still causing interrupts; this locked the system.

• Code for the GX_ITVC15 graphics driver has been removed for 
SH-3.

• The PPP Modem Dialer Utility (chat) has been removed for SH-3.

Compiler Issues

In order to reduce the memory usage, it was necessary to make C++ 
exception handling incompatible for SuperH. All code that uses 
exception handling need to be recompiled in order to be compatible with 
the C++ libraries. This change will result in significant savings in stack 
and global memory.
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Chapter 8: X86 Notes

This chapter provides an overview of the changes and improvements 
made to Enhanced OS-9 for X86. The following sections are included:

• Enhanced OS-9 for X86 v3.2
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8 X86 Notes

Enhanced OS-9 for X86 v3.2

The following sections represent changes and updates for OS-9 for X86 
version 3.2.

Resolved Problems

• CF12498: Adding PPP in PCAT Beginner mode makes the boot too 
big for a floppy.

PPP configuration is now grayed out for PCAT in Beginner mode; 
this stops user from including PPP modules and making the boot too 
big. PPP configuration is still available for PCAT in Advanced Mode.

• CF8171: Vectors in X86 is not setting the vector for the NMI.

The vector T_NMI can not be used with _os_irq to catch the NMI 
(Vector 2) because the vector table is not initialized with a jump to 
the vector code. 

This was fixed in edition #9 of 80386 vectors. 

• CF8398: Date utility missing from mw86sm.tar resident installation.

This problem has been fixed.

• CF9293: X86 Ed2 does not return an error on non-existent IDE 
device access (UK23978).

If a device is accessed that does not pysically exist on the system, 
an indefinte hang up occurs and no error code is returned.

This problem has been fixed in Edition #48 of the RB1003 driver. 
Now, if a device is accessed that does not physically exist on the 
system, the following error will appear:

"000:246  E$NotRdy - device not ready."  
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Also, Edition #39 of the RB1003 driver introduced a timeout during 
the init process. However, while this works on primary IDE drives, it 
does not handle the case of secondary drives. Because the same 
controller is used for both the primary and secondary drives, the only 
failure will occur on the actual drive init of the given device. 

Edition #48 of the IDE driver will now return error status on the drive 
init, initdrv. Typing dir /hd1 will now return an error if either the 
drive or contoller is not found. Therefore, there should be no more 
lockups or hangs. 

NoteNote
The time allowed for drive spin-up in init can be set via the 
ds_timeout field of the descriptor. 

• CF9972: Problems with RealTek RTL8139A Ethernet driver.

Transfers of large files using FTP from OS-9 target to a PC is very 
slow. There is also an MBUF leakage problem.

This problem has been fixed. Queued packet support has also been 
added and an m_offset offset alignemt issue fixed. 

NoteNote
Data must be quad word aligned.

SPF stops responding after entering ROMBUG

This problem has been fixed. SS_RombugOff has been enhanced 
to use IMR mask.  
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8 X86 Notes

• CF10077: A20 line handling fails on some laptops.

This problem has been fixed. The A20 code is in sysinit in 
coreboot. Two coreboots have now been built for X86. One contains 
a simple A20 toggle and the other contains a more complex toggle 
with error checking. The ladder is the default, but in some cases the 
former coreboot may work where the other fails. The Microware 
Configuration allows selecting either of the A20 line handlers.

• CF10140: The MediaGX graphic driver fails to update drawmap 
position in viewport. The gfx_set_vport_dmpos() call shows 
that the MediaGx graphic driver has no effect on the display. 

Since the MediaGX hardware does not support setting vport to 
positions other than the upper left corner (0,0), the driver now 
returns an error EOS_MAUI_BADPOS in fe_set_vpdmap() and 
fe_set_vpdmpos().

• CF11840: Ethernet initialization fails. If a target machine (using a 
3Com Ethernet card) is booted without a live connection to a 
network, the driver does not initialize the card correctly; this results 
in the error 000:175 (hardware damage) and the target must be 
rebooted. This problem was originally found using an EtherLink III 
ISA card.

A NO_LINK_BEAT option has been added in 
spe509/defs/spf.desc.h. If your 3Com Ethernet card is not 
initializing correctly when there is no live connection, set 
NO_LINK_BEAT to 1 in spe509/defs/spf.desc.h and recompile 
the descriptor. The driver then automatically sets the 
MEDIA_LINK_BEAT_OK flag, which allows the 
MEDIA_LINK_BEAT_ENABLE flag to be set. By default, however, 
NO_LINK_BEAT is set to 0,  allowing the code to execute the same 
as it did prior to the change.
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Enhancements

• CF12359: Intel PRO 100 low level driver needs way of over-riding 
MAC address.

Edition #20 of the LLPRO100 driver now honors the MAC address 
supplied in CNFGDATA. By default, support should be disabled for 
this feature since the MAC hardware address of the card must be 
resolved at the hardware level. On the Intel Ethernet PRO series, 
there is setup information along with the MAC address held in the 
82559 part itself. 

To enbale the MAC address override feature within the configuration 
Wizard the following statement needs to be added:

The port specific ini file normally does not 
display the MAC address. To display the MAC 
address for editing with in the Wizard change the 
SPF_MAC define to true.

[SUPPORTED_MODULES]

SPF_MAC=TRUE

Make sure that ROM/cnfgdata.des includes the following 
override:

/* Example cnfgdata.des entry */

#if defined(ROM_ETHERNET_IP_MAC_OVERRIDE)

#define ROM_ETHERNET_IP_MAC ROM_ETHERNET_IP_MAC_OVERRIDE

#else

#define ROM_ETHERNET_IP_MAC 00:00:00:00:00:00

#endif

string lleth_name = LLETH_NAME;

init llpm_interface_data[1] {

ip_address = ROM_ETHERNET_IP_ADDRESS; 

subnet_mask = ROM_ETHERNET_IP_SUBNET;  

brdcst_address = ROM_ETHERNET_IP_BROADCAST;

mac_address = ROM_ETHERNET_IP_MAC;

gw_address = ROM_ETHERNET_IP_GATEWAY;
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hwtype = LLPM_ETHER;

if_name = lleth_name;

port_address = LLETH_PORT_ADDRESS;

if_vector = LLETH_IF_VECTOR;

if_priority = LLETH_IF_PRIORITY;

if_level = LLETH_IF_LEVEL;

};

The Wizard creates a config.h file, which is included in the *.des 
files for Wizard overrides of cnfgdata data. Once the above 
changes are made, the new MAC address entered via the Wizard 
dialogs will be used for the low-level Ethernet driver.

• Code for the GX_ITVC15 graphics driver has been removed.

Known Issues

• CF12104: On the PCAT board, jview sends mem API errors when it 
terminates.

• CF14191: aurecord and auplay cannot specify the input/output 
device name and help.

• CF14204: aurecord does not work on the MediaGX board.

• CF14198: cdplay does not work on the PCAT board.

• CF14190: Setting tftpboot as the auto booter resets all the 
tftpboot parameters on the PCAT board.
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Chapter 9: Host Appl ications

This chapter contains release notes for host applications used with 
OS-9 version 3.2. It includes the following sections:

• Configuration Wizard Notes

• Hawk Notes

• HawkEye Notes

• TECH-CHECK Notes
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Configuration Wizard Notes

The following sections represent changes and updates for the 
Configuration Wizard, edition 1.75.

Resolved Problems

• CF4825: Problems with Wizard's Init Options screen.

You can now see the entire initialization string in the dialog box. In 
addition, users can keep a given string in a 20-item round-robin 
History List or a 20-item Protected List. Items may be moved freely 
between lists. A warning will appear when the maximum number of 
Protected items is reached. 

• CF10264: The Wizard is modifying the memlist table in a wrong way.

This issue occurs when the .ini file is modified incorrectly. An error 
message will now appear when the ROMSTART+ PAD_SIZE 
definition does not match an entry on the memlist from the .ini file. 

• CF11119: The Wizard makefiles get confused with user-runable 
makefiles.

The Wizard makefiles can be run with os9make once the Wizard 
has created install.com and core.ml, boot.ml, or both. 
Makefiles in all BOOTS/INSTALL/PORTBOOT directories have been 
modified to check whether or not Wizard-generated files exist. If 
Wizard-generated files do exist, the makefile continues as before. If 
not, os9make terminates, but not before you are advised to run the 
Wizard to create the missing files. 

• CF11150, CF11137: Error in contents of error_log.txt. 

When a module designed to be included in a bootfile is missing and 
you opt to terminate the build, the last line of error_log.txt will 
read, "Can't open <missing_module> in <file.ml>!" When you opt to 
continue the build from here, another message is written to 
error_log.txt stating, "Module <module> in <file.ml> not 
included."
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Enhancements

General Enhancements

• Initialization parameters are limited to 994 characters.

A bootfile build will fail when the initialization parameters string is 
larger than 994 characters. A counter on the user-defined 
initialization string screen warns when space is running short.

• There are no more defaults for hostname and domain name.

Warnings are given when DNS is enabled and relevant DNS 
information (hostname and search string) is not given. The Wizard 
no longer fills in hard-coded hostname and domain name defaults 
when these items are not defined by the user.

• CF11137: Better error messages needed when add-ons are not 
installed. 

A new “file not found” message has been designed to appear during 
builds. This message will remind you to be certain all add-ons are 
properly installed. You can then choose to continue the build without 
the missing module or to abort the build. Any skipped modules are 
listed in the build output window.

TFTPBOOT and BOOTP Support Enhancement

The Wizard now includes support for TFTPBOOT. Board ports must be 
modified slightly for this functionality. The Wizard also supports BOOTP 
Request configuration, but no booter exists at this time. 

For More Information
More In
fo More 
Informatio
n More Inf
ormation M
ore Inform
ation More

-6-

Refer to MWOS/SRC/TOOLS/WIZARD/DOC/WizardChanges.doc, 
pages 29-34, for details and instructions on using this new functionality.
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Rejected Enhancements

• CF12386: The Wizard does not include spenet and enet in the boot 
when Ethernet is disabled.

spenet and enet are the driver and descriptor for Ethernet; thus, they 
are not included when Ethernet is disabled.

• CF12551,10264: Have Wizard ignore wrong memlist information 
instead of destroying table.

The Wizard will deliver an error message and terminate the build 
when the wrong memlist information is defined by the user. 
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Hawk Notes

The following sections represent changes and updates for Hawk 2.3.

Resolved Problems

• CF12175: Default CPU for project is wrong. When opening an 
existing project, the chip type on the General tab (Project -> 
Properties) shows a default of "68000" regardless of whether or not 
OS-9 for 68k was installed. 

This problem has been fixed. Currently, instead of 68000, the default 
is the first processor found installed on a user's system. 

• CF12434: Access violation in hawkprj.dll 2.2.4.10 when 
changing project properties. 

Previously, if you selected Project -> Properties, then modified the 
properties and closed the dialog, an access violation would occur. 

This access violation occurred when the Project Properties dialog 
closed because it was trying to save material from the component 
properties, not the project properties. This problem has been 
corrected.

• CF12435: Hawk 2.2 is showing the contents of a project/component 
in a wrong order. 

The sort “A to Z” has been fixed so that the first time it is clicked it 
will sort from A to Z. Previously, it was sorting from Z to A if things 
were already in order. A "by build order" option was also added to 
the sort menu so that the source files will be put in the order in which 
they are compiled.



46 Enhanced OS-9 Release Notes

9 Host Applications

• CF12587: Add “force” option, return error (unlink module)

A check box with the caption “Force Unlink” has been added to the 
Unlink dialog box. If this item is checked when the Unlink button is 
clicked, the specified module will unlink. The method used to unlink 
modules will return a boolean value when an unlink is attempted. 
Previously, if “false” was returned (meaning the unlink failed), no 
evidence of a failure was displayed. Currently, if false is returned, an 
error box will appear with a message stating that the unlink failed.

• CF12606: Cannot clear component description.

Previously, it was not possible to clear the description from a 
component. Clearing the field caused a change to the Edit mode. In 
addition, when the green check was pressed, the description 
remained unaltered even though the dialog returned to Browse 
mode; closing and re-opening the dialog showed the original 
description unchanged. Hawk was incorrectly handling a case in 
which there was already a description for a component, and it was 
being reset to NULL. This problem has been fixed.

• CF12678: Hawk bug moving projects.

On some occasions, moving a project used to result in the incorrect 
changing of some paths to source files. Initially, the filenames in the 
project were inserted with a full path instead of a relative path. This 
caused problems if the project was moved. This problem has been 
fixed. Currently, the filenames are inserted with a relative path; 
therefore, moving a project is acceptable.

Enhancements

• CF12244: In the Hawk Profiler, the Function column does not sort 
like all of the other columns on the main and function screens. 

The Profiler has been enhanced. It will now select the manner in 
which functions are sorted by clicking on the headings of the table in 
the Functions screen.
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• CF12482: Hawk Profiler.

A grid has been added to the CPU and Memory usage tables in the 
Profiler. The amount of time elapsed between vertical lines in the 
grid is now also displayed on the Profiler. The horizontal lines of the 
grid are 25%, 50%, and 75%.

• CF12589: When adding a unit, default to current component (not 
first one). 

Previously, if you attempted to insert files into Hawk, Hawk would try 
to insert the files into the first component in the project. An 
enhancement has been made to Hawk concerning this problem. 
Now, Hawk will make the currently selected component the default 
component in the dialog. This component will then appear when files 
are added using the drag-and-drop method.

• CF12671: mwdock22.dat should be saved in MWOS\DOS\BIN.

Previously, the directory in which Hawk launched was the same 
directory that contained the file mwdock22.dat, which stored 
docking information for that Hawk session. Potentially, a user could 
have several different copies of mwdock22.dat on his/her machine. 
This problem has been solved. Currently, Hawk looks in 
MWOS\DOS\BIN when opening and saving mwdock22.dat.

• CF12681: Load modules from the DOS command line of the Host 
machine.

An “-L” option has been added to hawkdbgr to allow for the loading 
of modules from a DOS command line. Formerly, the command, 
hawkdbgr -T=neptune -L=d:\projects\cf12681, would 
load modules onto the target neptune. 

If more than module is loaded, use a; to delimit the list of modules 
(such as hawkdbgr -t=neptune 
-L=d:\projects\cf12681;c:\module). For a full list of 
available command line options, type hawkdbgr -?.

• CF2686: Profiler launcher application needs rewriting.

The shell window that contains the Java command used to launch 
the Profiler is no longer displayed when the Profiler is launched from 
Hawk.
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Known Issues

• CF14238: Hawk client does not work right if registry is not modified 
by the installer.

If you install the Hawk Client in a directory with more than eight 
characters, Hawk will not support the full path to the configuration 
files. This is evident in the Project Properties dialog.

• CF14284: The Help button in the Tools -> Version Control -> 
Setup dialog does not bring up a help file.

Help is accessible for this topic, however, via the Help -> Contents 
and Index menu item.

• CF14254: Setting a breakpoint in a file in a directory with spaces in 
the name does not work.
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HawkEye Notes

No additions have been made to HawkEye since the last release. 

For More Information
More In
fo More 
Informatio
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ation More

-6-

For the latest HawkEye release notes, refer to the Enhanced OS-9 
Release Notes v3.1 document, included with this CD.
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TECH-CHECK Notes

No additions have been made to TECH-CHECK since the last release. 

For More Information
More In
fo More 
Informatio
n More Inf
ormation M
ore Inform
ation More

-6-

For the latest TECH-CHECK release notes, refer to the Enhanced 
OS-9 Release Notes v3.1 document, included with this CD.
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Chapter 10: Components

This chapter contains target processor-independent release notes for 
OS-9 components. It includes the following sections:

• OS-9 Compiler Notes

• PersonalJava Solution for OS-9 Notes

• Networking Notes

• MAUI Notes

• SNMP Notes

• OS-9 Utilities Notes
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OS-9 Compiler Notes

The following sections contain release notes for the OS-9 Compiler 
v2.5.

Resolved Problems

• CF2677: Linker cannot set file attributes on .stb file.

The linker was changed to do a better job of setting the requested 
file attributes on the .stb and .dbg files generated for a particular 
executable.

• CF2768: Shifting is inconsistent.

The RISC processor assemblers no longer cause the right shift of 
external symbols to be done unsigned. The assemblers were 
already right shifting internal symbols in a signed fashion. Thus, the 
right shift of a symbol is now consistent with regard to the assembler 
and linker, both for internal and external symbol references.

• CF7424: Floating Point Emulation Problems.

This was a problem with the pow() function in RISC C libraries. It 
was incorrectly handling underflow in some situations. This problem 
has been fixed.

• CF9886: Some strange things with Cpp using maps.

The demonstration program caused problems because it generated 
symbol names near 2130 characters in length. rdump and the linker 
have been fixed to handle these long symbol names. (Previously, 
they were limited to 2048 characters.) They now accept any length 
symbol name. Edition #32 or better of rdump and edition #160 or 
better of the linker correct this problem.

• CF10265: C++ using rw/tvslist.h cannot be compiled.

The header file \MWOS\SRC\DEFS\rw\stdex\defs.h is now 
included by \MWOS\SRC\DEFS\rw\stdex\slist.h. This allows 
slist.h to be included by any C++ application.
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• CF10798: Different modules from Win98/2000, UltraC.

In the icode optimizer there is a data structure called a “set”, which 
may be ordered or unordered. For an ordered set, a comparison 
function is generally specified to determine how to order the items in 
a given set. Previously, if no comparison function was specified, the 
default compared the addresses of the items. This caused ordering 
discrepancies between the same sets on hosts of with different 
memory environments. 

Currently, if no comparison function is specified, the set will remain 
unordered. All new items will be added at the end of the list of items 
in the set. Thus, the set will always be ordered the same way and 
optimization decisions will be made on with the same data ordering 
method.

• CF10815: iopt could do better CSEs in ll8139.

The I-code optimizer was modified do generate more optimal code 
on processors with 32 or more general purpose registers. It was 
being too optimistic about the memory addressing capabilities of the 
underlying machines.

• CF11156: R68 leaves zero-byte file if assembler fails.

All assemblers were changed to, by default, delete any output file in 
the case of errors. A new option (-k) was added to allow the 
incomplete output file to be kept.

• CF11176: xcc file name limit.

The temporary directory name (-td option) was limited to about 60 
characters. This problem has been corrected. There is now no limit 
to the length of a temporary directory name.

• CF11236: The linker's thread violation error message is difficult to 
comprehend. 

The threading violation linker error/warning message was fixed to 
include meaningful information about the reason for the threading 
violation. It now includes both the threading status of the violating 
object and the prior objects.
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• CF11605, 11606: Inaccurate help on Ultra C front end. The help text 
for cpfe is incomplete. 

The help for the front end was fixed. Necessary options have been 
added. A few other options contained inaccurate descriptions; these 
were corrected. The listing was then alphabetized by short option 
and secondarily by long option.

• CF11742: C++ exception handling failed when using multiple 
threads.

Exception handling used certain globals that were being corrupted 
due to multiple threads using them simultaneously. These globals 
were changed to use thread-local data instead of global variables.

• CF11853: Compiling certain files causes appc.exe to crash.

This problem only occurs in rare circumstances when a program is 
being compiled for debug (-g).

• CF11854: Wrong modifications in \MWOS\SRC\DEFS\queue 
causes C++ not to compile.

The following files were modified: \MWOS\SRC\DEFS\queue, 
\MWOS\SRC\DEFS\iterator, and \MWOS\SRC\DEFS\istream. 
Some incorrect modifications to these files were causing friend 
template functions to be instantiated although they were not 
referenced anywhere in the program. The files were reverted back to 
their previous state, only requiring the friend template functions to be 
instantiated if they were used in the program.

• CF11895: Threading libraries should not default to stack checking.

The threading libraries were changed have stack checking disabled 
for those functions that only used a little stack. This resulted in 
significant performance improvement in the threading libraries.
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• CF12058: Process const pointer lost when signal arrives if using 
subroutine module.

The intercept() and signal() library routines could, under 
certain circumstances, call your signal handler with an incorrect 
constant pointer in place. The following criteria must be met in order 
for this to be a problem:

• program compiled for processor with a constant pointer

• constant pointer required by the signal handler

• I-code linked program

• -bepg not used

• non-CSL subroutine module being employed

If a signal arrives while the current PC is in the subroutine module, 
the CP set for the signal handler will be that of the subroutine 
module. This problem has been corrected with the setting of CP 
properly in all cases. _os_intercept() will still suffer from this 
problem.

• CF12159: Compiler is generating huge program.

The front-end was changed so that it does not automatically 
generate zero-filled initialized data for C++ arrays. The arrays will 
still be initialized to zero, just not as part of the initialized data.

• CF12191, 12372: A bug in three string library functions in clib.l. 
Compiler is generating wrong Initialized Data for Structure.

The Ultra C front end was duplicating some padding when 
generating the initializer for an array of structures with initialized 
unions.
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Enhancements

• CF2738, 9082: Allow C++ style comments within C code.

An executive (xx) command line option, -cq, was added to allow 
C++ style comments (comments beginning with "//" and ending at 
the end of a line) in C programs. This option can also be executed by 
passing the option --cpp_comments_allowed to the front end.

• CF7036: Linker should report location of offending reference (RFI).

The linker was enhanced to include more information when symbols 
are out of range. The symbol that was out of range is reported. Also, 
the error message has better documentation on correcting the 
problem.

• CF10229: Add a command line option to the linker to set the module 
revision.

The linker has been modified so that the attribute/revision field 
variable in the module header can be modified via the linker 
command line or by using an assembly language statement to set a 
global definition. 

There are several global definitions that are examined to determine 
the attribute revision word. Currently, _m_attrev and _sysattr 
will override any other values; in addition, m_attrev will have 
precedence over _sysattr. The modification causes the linker to 
override the revision portion of the attrev value set in any other 
location. This global definition, named _m_rev, overrides the rev 
part of attrev set by any other means, including _m_attrev, and 
_sysattr. If none of _m_rev, _m_attrev, or _sysattr is set, the 
revision value set on the command line is used for the revision 
number. The command line option is R, the syntax is -R=nnn (where 
nnn is less than 256). A value greater than 255 causes a fatal link 
error.
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PersonalJava Solution for OS-9 Notes

No additions have been made to PersonalJava since the last release. 

For More Information
More In
fo More 
Informatio
n More Inf
ormation M
ore Inform
ation More

-6-

For the latest PersonalJava release notes, refer to the Enhanced OS-9 
Release Notes v3.1 document, included with this CD.
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Networking Notes

The following sections include the release notes for SoftStax/LAN 
Communications Pak v3.6.

Protocol Modules

• spip

CF12565: In some situations spip can generate occasional bad 
checksums.

This problem has been fixed.

Utilities

• ftpd

CF11264 and CF11872: The FTP server causes the system to 
hang.

Under some situations, typing an incorrect password would cause 
the entire system to hang. This was due to a file I/O problem with 
non-threaded applications. The problem has been fixed.

• ping

Exits when an ICMP redirect is received.

This no longer happens. Currently, when an ICMP redirect is 
received, a notification will be printed and ping will continue to wait 
for a response.

• dhcp

If the hostname is set, it is now included in DISCOVER and 
REQUEST packets.
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Drivers

• PPP

CF12481, CF12322: The sppscf driver, which handles the 
interaction between the SCF serial driver and the SoftStax PPP 
drivers, was not setting the SCF driver's global pointer correctly. This 
stopped any SCF driver using global data from working properly with 
PPP. Currently, the sppscf driver performs this task correctly; all SCF 
drivers should now work with PPP.

CF10563: Both the 10Mbit (sps8260) and 100Mbit (spf8260) now 
work correctly with the data cache enabled. Previously, occasional 
packet loss occurred. 
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MAUI Notes

No additions have been made to MAUI since the last release. 

For More Information
More In
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For the latest MAUI release notes, refer to the Enhanced OS-9 
Release Notes v3.1 document, included with this CD.
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SNMP Notes

No additions have been made to SNMP since the last release. 

For More Information
More In
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For the latest SNMP release notes, refer to the Enhanced OS-9 
Release Notes v3.1 document, included with this CD.
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OS-9 Utilities Notes

The following section represents changes and updates for the OS-9 
utilities.

Enhancements

• CF8597: Add additional queue information to procs -x. 

procs has been modified so that the queue status is now given in 
words when option –x is used. When a user-state process is waiting 
for an event, the Event ID of that event is given.
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